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ArcGIS Pro: Tips and Tricks for Exploring Your Attributes

Tables, Pop-ups, Reports

Today we’re going to discuss our favorite tips and tricks for working with attributes in:

and
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Attributes in the Table



Attributes in the Table: What is a table?

Rows

Columns (Fields)

Values in cells are attributes



Map layers

Attributes in the Table: Common table types



Map layers

Attributes in the Table: Common table types

Standalone tables



Map layers

Attributes in the Table: Common table types

Standalone tables

Some common table 
types:
• Feature classes
• AGOL feature services
• Shapefiles
• Database tables
• Excel spreadsheets
• .csv files (text files)



Attributes in the Table:  New control in Pro 2.8

Faster rendering, reduced latency in scrolling, and more stability



Attributes in the Table:  Anatomy of the table

Toolbar



Attributes in the Table:  Anatomy of the table

Table menu



Attributes in the Table:  Anatomy of the table



Attributes in the Table:  Anatomy of the table

Status control



Attributes in the Table:  Navigating in the table

Open the table using Ctrl + T or Ctrl + double-click 



Attributes in the Table:  Navigating in the table

Use the keyboard arrows, Enter, and Tab to navigate

See the help 
documentation for a 
full list of shortcuts: 

bit.ly/2SaGqGl



Attributes in the Table:  Navigating in the table

Move to beginning or end of the table



Attributes in the Table:  Go to row number

Note: The row number does not always 
correspond with the OBJECTID



Attributes in the Table:  Organizing your data

Reorder the fields in your table to make it easier to read.



Attributes in the Table:  Organizing your data

Temporarily hide unnecessary fields in your table.



Attributes in the Table:  Organizing your data

Freeze important fields and promote them to the 
beginning of the table



Attributes in the Table:  Organizing your data

Date Format dialog launcher

New in Pro 2.8, new date time formatting options



Attributes in the Table:  Organizing your data

New in Pro 2.8, new date time formatting options

Pre-defined list or custom format



Attributes in the Table:  Visualizing your data

Select rows in a table



Attributes in the Table:  Visualizing your data

Highlight rows in the “Show selected records” view



Attributes in the Table:  Filtering your data

Toggle buttons to filter table 
by map time, range or extent



Attributes in the Table:  Filtering your data

Sort indicator (enabled 
when table is sorted)



Attributes in the Table:  Editing your data

Type directly into a cell to start editing.

Note: Always 
click “Save” from 
the Edit tab after 

you’re done



Attributes in the Table:  Editing your data

Copy Excel data and paste it directly into your table

Note: New rows 
are created if the 

pasted data 
contains more 
rows than the 

table, new fields 
are not created



Attributes in the Table:  Editing your data

Find values in the table and replace them with new values



Attributes in the Table:  Editing your data

Insert new rows into standalone tables



Attributes in the Table:  Joins and related data

Add Join GP tool Add Relate GP tool



Attributes in the Table:  Joins and related data

One-to-one relationship

San Diego County is only 
related to the state of 

California

Use joins for these 
relationships



Attributes in the Table:  Joins and related data

One-to-many relationship

California has many counties

Use relates for these relationships



Attributes in the Table:  Joins and related data

Joins and relates are 
temporary

Create a relationship class at 
the database level for a 

permanent solution.



Attributes in the Table:  UI options and customization

Prevent creating non-spatial rows by hiding the “Click to 
add new row” option at the bottom of the table.



Attributes in the Table:  UI options and customization

Set default options for how and where tables will open.
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Organizing and 
Editing a Table in 
Pro



Attributes in a Pop-up
Jill Scholz



Attributes in a Pop-up:  The Explore tool

The Explore tool is the default tool for both maps and scenes.



Attributes in a Pop-up:  The Explore tool

Expand the drop-down to control which layer returns pop-ups.



Attributes in a Pop-up:  The Explore tool

My personal favorites: 
Visible Layers and 

Selected in Contents.



Attributes in a Pop-up:  The Explore tool

My personal favorites: 
Visible Layers and 

Selected in Contents.



Attributes in a pop-up:  The Explore tool

Single-click to open read-
only listing of attributes 
currently visible in table.



Press the Ctrl key and 
drag a box to open pop-
up for multiple features.

Attributes in a pop-up:  The Explore tool



Tree view listing all identified items 
grouped by layer

Attributes of one feature at a time

Attributes in a pop-up:  Parts of a pop-up



Attributes in a pop-up:  Parts of a pop-up

Image attachments are included below



Attributes in a pop-up:  Parts of a pop-up

Drag gray section divider to resize



Hover over to reveal quick buttons that..

Attributes in a pop-up:  Parts of a pop-up



Hide the Top portion

Attributes in a pop-up:  Parts of a pop-up



Hide the Bottom portion

Attributes in a pop-up:  Parts of a pop-up



Attributes in a pop-up:  Parts of a pop-up

Drag gray divider to reveal hidden side



Switch to side-by-side orientation

Attributes in a pop-up:  Parts of a pop-up



Attributes in a pop-up:  Pin a pop-up

Pin a pop-up to compare attributes



Attributes in a pop-up:  Pin a pop-up

Right-click to open as a pinned pop-up



Attributes in a pop-up:  Pin a pop-up



Attributes in a pop-up:  Pin a pop-up

Pinned pop-ups remain 
until closed or returned



Attributes in a pop-up:  Pin a pop-up

Pin as many as 
you want!



Attributes in a pop-up:  The Configure Pop-ups pane

Pop-ups can be more
than a simple attribute list



Attributes in a pop-up:  The Configure Pop-ups pane

Right-click the layer in the Contents pane..



Attributes in a pop-up:  The Configure Pop-ups pane

.. to open the 
Configure 

Pop-ups pane.



Elements in a pop-up:

• Text

Attributes in a pop-up:  The Configure Pop-ups pane



Elements in a pop-up:

• Text

• Fields

Attributes in a pop-up:  The Configure Pop-ups pane



Elements in a pop-up:

• Text

• Fields

• Image

Attributes in a pop-up:  The Configure Pop-ups pane



Elements in a pop-up:

• Text

• Fields

• Image

• Chart

Attributes in a pop-up:  The Configure Pop-ups pane



Elements in a pop-up:

• Text

• Fields

• Image

• Chart

• Carousel - Multiple Images and 

Charts in a gallery

Attributes in a pop-up:  The Configure Pop-ups pane



Attributes in a pop-up: Building with elements

Add or change elements

• Add new element to end - Single click



Attributes in a pop-up: Building with elements

Add or change elements

• Add new element to end - Single click

• Replace element - Click and drag



Attributes in a pop-up: Building with elements

Add or change elements

• Add new element to end - Single click

• Replace element - Click and drag 

• Swap two elements – Click and drag



Attributes in a pop-up: Creating a grid

Assemble elements into a grid-like formation

• Split horizontally – Two side-by-side elements



Attributes in a pop-up: Creating a grid

Assemble elements into a grid-like formation

• Split horizontally – Two side-by-side elements

• Split vertically - Two stacked elements



Attributes in a pop-up: Creating a grid

Assemble elements into a grid-like formation

• Split horizontally – Two side-by-side elements

• Split vertically - Two stacked elements

• Horizontal arrangement



Attributes in a pop-up: Creating a grid

Assemble elements into a grid-like formation

• Split horizontally – Two side-by-side elements

• Split vertically - Two stacked elements

• Horizontal arrangement

• Rotate left 90°
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Demo: Pop-up 
Customization



Attributes in a pop-up:  HTML mode availability

HTML mode is available for all elements

• Image and Charts – Titles and captions

• Fields – Converted to pre-populated Text element



Attributes in a pop-up:  The final pop-up

Additional changes:

Color coding 
Font size changes

Two lined Image title



Attributes in a pop-up:  The final pop-up

Reminder:

Here is what the 

original pop-up 

looked like.



Attributes in a pop-up:  When publishing

Not all items are currently supported online

• Grid will be condensed into single column

• Unsupported numeric/date formatting lost

• Images sourced from local URLs removed



Pop-ups hide when we 
change map focus

Attributes in a pop-up:  Focus changes

and pop up again 
when we return.

Final tip:
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Attributes in the Report:  What is a report?



Attributes in the Report:  What is a report?

Well-formatted, multipage 
representation of your data



Attributes in the Report:  What is a report?



Attributes in the Report:  What is a report?



Attributes in the Report: Creating a new report

Create a new report from a 
map layer



Attributes in the Report: Creating a new report

Create a new report from a 
map layer

Create a new report from the 
Insert tab on the ribbon



Attributes in the Report: Creating a new report

Set the report name 
and data source on 

the first page.

Tip: Click the navigation 
dots at the top of the pane 

to go to any page



Attributes in the Report: Creating a new report

Define rows and 
fields included in 

your report

Note: The fields list 
honors visibility



Attributes in the Report: Creating a new report

Define rows and 
fields included in 

your report

Note: Grouping allows you to aggregate your 
data based on a unique value. In this case, 

grouping by the field “STATENAME” will create 
a report that first lists “Alaska” and then 

Alaska’s cities before moving to “Arizona”



Attributes in the Report: Creating a new report

Define the look of 
your report using 

templates and 
styling

Tip: Hover over template and 
styling options to get more 

information.



Attributes in the Report: Creating a new report

A report is a project item

A Reports folder will  
contain all of the reports 

in your project.



Attributes in the Report: The Report view

The report view does not represent a page, it is a design space



Attributes in the Report: The Report view

Headers appear at the beginning of the report



Attributes in the Report: The Report view

Footers appear at the end of the report



Attributes in the Report: The Report view

The details section is where your tabular data is listed



Attributes in the Report: The Report view

Every section has a contextual tab with options



Attributes in the Report: Report properties

Report Document properties dialog



Attributes in the Report: Editing report elements

Add dynamic elements from the Insert tab

Note: The options are contextual and depend on the current active section. The 
hover tooltips will provide more information when the buttons are disabled.



Attributes in the Report: Dynamic report elements

Attachments for Canyonlands National Park



Attributes in the Report: Dynamic report elements

Use the Format Attachment Frame 
pane to define properties for your 

attachments



Attributes in the Report: Dynamic report elements

Insert a dynamic picture using a 
field or an Arcade expression



Attributes in the Report: Dynamic report elements

Visitor Counts over time for National Parks and Monuments in California

Visitors (2010)
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Insert charts into report and group header or footers

Note: The chart must already 
exist for the layer



Attributes in the Report: Related reports

Note: The report data source must 
be the input or origin table in the 

relate or relationship



Attributes in the Report: Creating related reports

Select the relate or 
relationship class 
and set the related 

report name



Attributes in the Report: Creating related reports

Page 2 and 3 are the 
same as the Create 
New Report pane



Attributes in the Report: Creating related reports

Set the related report 
template and styling



Attributes in the Report: Creating related reports

A related report in the Contents pane



Attributes in the Report: Supplemental pages

From the Insert tab, the page will be added to the end of the report

Use the Contents pane 
context menus to insert a 
page to a specific location



Attributes in the Report: The Report Document view

With the top node selected, the Report Document view displays 
information and metadata for the report and any supplemental pages



Attributes in the Report: The Report Document view

Report context menu Supplemental page 
context menu

Report Document view context menus for both the report and 
supplemental page sections 



Attributes in the Report: Sharing a report

Save the report definition to file 
(similar to .mapx or .pagx)

Report files can be imported 
from the Insert tab



Attributes in the Report: Sharing a report

Export a report to PDF

Export Report pane



Attributes in the Report: Sharing a report

Page Settings tab

Page Range

Custom Page 
Numbering

Tip: Use custom page 
numbering to stitch 

multiple reports together 
using arcpy



Attributes in the Report: Sharing a report

Export Report to PDF GP tool

Export a report or 
a report file

Set an expression

Page Range 
Options



Attributes in the Report: Sharing a report

Automation options

arcpy (export existing reports)
.NET SDK (authoring and exporting reports)
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Authoring and 
Sharing a Report in 
Pro



ArcGIS Pro: Tips and Tricks for Exploring Your Attributes

Tables Pop-ups Reports

Today we discussed our favorite tips and tricks for working with attributes in:

and



We want your feedback
Click on the Session Survey link 
below this video window
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